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THE LEADERSHIP LEDGER 

Volume 3  Issue 4 

February 17, 2022 

The American Legion, Department of Maine   
5  Verti Drive, Winslow, Maine  04901-0727 

www.mainelegion.org | legionme@mainelegion.org | 207-873-3229 

Facebook: www.facebook.com/maineamericanlegion 

W elcome to the 60h Edition of The Leadership 
Ledger. It includes Post, Department and  

National reports, leadership training events, upcom-
ing conferences/conventions as well as rules and 
regulations pertaining to local, state and national 
laws. The Ledger is available by visiting the  
Department’s website at www.mainelegion.org  
under “News & Events” or on the home page. If you 
have any information to be published in The  
Leadership Ledger, please forward to Department 
HQ via email at: legionme@mainelegion.org. 

 

ORATORICAL CONTEST WINNERS 
 

C ongratulations to Shawn Jiminez of West  
Gardiner for winning The American Legion  

Department of Maine’s High School Oratorical  
Contest on February 12th at Thomas College in 
Waterville! Shawn represented District 9 and  
Litchfield Post 181. The title of his oration was 
“March 4th 1789.”  In April he will travel to  
Indianapolis to compete at National. For winning the 
contest on the State level, Shawn received $1500 
and has a chance of winning up to $25,000 at  
National.   

Congratulations also go to 2nd place winner Joshua 
Werner, representing District 1 and Sanford Post 19; 
3rd place to Mateus Campos, representing  
District 2 and South Portland Post 35; and 4th place 
to Tristan Darwin for representing District 8 and 
Brunswick post 20. 

Many thanks to all contestants who 
competed at the State level! 

THE LEGION FAMILY LUGE 

Date:  February 26, Saturday 
8am Registration and 9am Start 

Where: Camden Snow Bowl 
20 Barnestown in Camden 

Cost: $25 Per Person to Benefit  
The American Legion  
Department of Maine Foundation 

S ons of the American Legion, Detachment of 
Maine, presents the 2nd Annual Running of the 

Sleds. Bring a crowd from your Legion Family and 
compete for fastest times, best costumes, and bragging 
rights. The Camden Snowbowl is the place to be to 
see the Legion Family compete in a death-defying 
race down the icy boards.  Costumes are  encouraged! 

The celebration begins Friday, February 25th to kick 
off the weekend with a Spaghetti Feed at American 
Legion Post 1 Rockland, $10 pp. There will also be a 
welcome party after the meal to size up the competition 
and for some friendly trash talk. 2-4 people per 
toboggan. Sleds available at event. Registration 
starts at 8 am.  If you plan on eating on the 25th  
contact Post 1 with a headcount 594-2901. 

Prize categories: Sweetheart Run, Best Costumes, 
Team Spirit, Best time/Fastest Run. 

Coffee and food will be available for a fee, porta 
potties on site. 

Special rate on hotel rooms: Tradewinds – Suites 
are $129 + tax per night, breakfast included. 596-6661.  
Rockland Harbor – $99 plus tax for Harborview 
Balcony rooms, 13 with 1 king, 12 with 2 queens. 
Block held until January 25, but rate still available 
after the cutoff. Breakfast included. 594-2131. 

Guests call on their own, reference “Legion Luge” 
group. Please book before February 15th. FMI call: 
207-701-9676.   

 
 

PRESIDENT’S DAY  

T he Department Headquarters Office and the Service 
Office will be closed  on Monday, February 21, in 

observance of President’s Day.  Please plan accordingly.                                 

 

http://www.mainelegion.org
mailto:legionme@mainelegion.org
http://www.mainelegion.org
mailto:legionme@mainelegion.org
https://en.wikipedia.org/wiki/Preamble_to_the_United_States_Constitution
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MARINE CORPS LEAGUE 
CENTRAL MAINE 
DETACHMENT 810 

SPECIAL INVITATION 

 

T he Marine Corps League, Central Maine 
Detachment 810 and the Lewiston/Auburn  

Veterans council will host a Remembrance tribute to 
our Vietnam War/Vietnam Era veterans. Following 
the tribute, we will travel to the Lewiston Veterans 
Park for the presentation of memorial wreath at the 
Vietnam war memorial. The date is March 29, 2022. 
The time will be 10am to 11:30am.  

We would consider it an honor if you could take part 
in our tribute to our men and women who served 
during America’s most controversial war. Help us  
WELCOME HOME a group of veterans who did 
their job and received a nation’s scorn on their return. 

If you are interested in participating, please contact 
Charlie Paul at 207-393-7667 or:      

charlespaul293@gmail.com. 

Semper Fi 

Charlie Paul, Comdt, Central Maine, Det. 810 MCL 
Sr Vice Commandant, Dept. of Maine MCL 
 

 

VETS IN THE VALLEY   
WINTERFEST 

Good Day Veteran Advocates- 

On behalf of Lost Valley Ski Area, we are pleased to 
announce the return of “Vets in the Valley – Winter-
fest” on Saturday March 19, 2022.  For those who 
may not be familiar with this event, it is a day of no 
or low cost skiing and winter activities for Veterans, 
military members and their families to enjoy outdoor 
recreation.  This event is hosted by Lost Valley Ski area in 
Auburn and runs 9 am to 4 pm.  Because this is a Veteran 
event, we also like to have Veteran Resources onsite to 
provide information on various support services and  
resources for the military community.  

This is where you come in.  Your organization has 
been identified as a resource that currently provides 
services to the military community or has the  
potential to provide services.  If you are interested in 
attending to promote your organization, please email 
your name, organization, and contact information for 
the onsite representative to Leo Deon at 
Leo.J.Deon@maine.gov.  Don’t delay as space is 
limited. The deadline for signing up is Wednesday, 
March 16, 2022.  Additional information will be provided 

to those organizations who sign up to participate.   
Please call or email with any questions and we look 
forward to having  your organization join us.       

Yours in Service,  

Leo 

Leo J. Deon Jr. (CWO, U.S. Coast Guard-Ret) 
Local Veterans’ Employment Representative 
Maine Hire-A-Vet Campaign  
2020 Co-Coordinator 
Franklin County MMCN Chair 

 
Make Your Name Part 
of The American Legion 
History 

Become a Sponsor Today in 
Support of Maine Veterans! 

Deadline for Submission 
is May 6, 2022 

Become a sponsor of our Maine American Legion 
Convention yearbook as an “individual donor” and 
help support Veterans in the Sate of Maine.  As a  
contributor, your name (individual or business) will 
be listed in our 2022 Maine American  Legion 
yearbook and made available in print and online in 
digital format on www.mainelegion.org. 

Donations may be made by 
clicking on the DONATIONS 
WELCOMED button located 
on our Legion website at       
www.mainelegion.org 

and selecting “Donate with Debit or Credit Card”, or 
by check payable to The American Legion, Depart-
ment of Maine, 5 Verti Drive, Winslow. 

Show your support to our Veterans in the State of 
Maine! Become a sponsor today and make your 

name part of The American Legion History 

To purchase ad space, please submit payment along 
with Maine American Legion Convention Yearbook 
Sponsorship Request Form (see page 10 & 11) or 
visit www.mainelegion.org.      

 
 

DISTRICT MEETINGS 

Be Connected – Be Heard – Be Informed 

District 8 – Sagadahoc: Feb 27 
Topsham Post 202, 1:00PM 

District 14 – Piscataquis: Feb. 19  
Dover-Foxcroft Post 29, 12 pm Lunch Mtg at 1PM 

District 7 – Lincoln: Mar. 3 
Waldoboro Post 149, 6:30PM 

https://indd.adobe.com/view/9a3f816d-3838-4d55-99e3-c7a37f33ac0b
mailto:Leo.J.Deon@maine.gov
http://mainelegion.org/
http://mainelegion.org/
http://mainelegion.org/
https://www.paypal.com/donate/?cmd=_s-xclick&hosted_button_id=WEKL5GPUELPMU&source=url
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COMMANDER’S PROJECT 

2021-2022 

American Legion  
Department of Maine Foundation 

T he American Legion, Department of Maine 
Foundation is a 501(c)(3) non-profit organization 

exclusively for charitable purposes.  All donations to 
the foundation are tax deductible under the United 
States Tax Code and Internal Revenue Service. 

The Mission of the Foundation is to provide finan-
cial assistance, promote Americanism, Youth  
Programs, National Security, and Veterans Affairs 
and Rehabilitation that will enhance the lives of our  
veterans, their families, children and communities in 
the State of Maine today and for future generations. 

My goal this year is to raise $15,000 for the Endowment 
Fund to help fund American Legion Americanism 
Programs. Examples include Baseball, Dirigo (Boys) 
State, and the Oratorical Scholarship program. 

America’s future lies in our children. 

American Legion Baseball, founded in 1925, has 
taught hundreds of thousands of young Americans 
the importance of sportsmanship, good health and 
active citizenship. The program is also a promoter of 
equality, making teammates out of young athletes 
regardless of their income levels or social standings.  

At Dirigo (Boys) State, participants learn the rights, 
privileges and responsibilities of franchised citizens. 
The training centers on the structure of city, county and 
state governments. Students are elected to various offices. 
Activities include legislative sessions, court proceedings, 
law-enforcement presentations, assemblies, bands, and 
recreational programs.  The two representatives elected to 
represent Maine at Boys Nation in Washington,  
of federal government. 

The American Legion Oratorical Contest exists to  
develop deeper knowledge and appreciation for the 
U.S. Constitution among high school students. Since 
1938, the program has presented participants with an  
academic speaking challenge that teaches important 
leadership qualities, the history of our nation’s laws, 
the ability to think and speak clearly, and an  
understanding of the duties, responsibilities, rights 
and privileges of American citizenship. 

All these programs help to train and shape our youth 
into outstanding citizens.  Many will become our  
future leaders and many may become leaders in the 
American Legion. 

I am asking all of you: Legionnaires, Legion Posts, 
and Districts to please contribute to this endowment 
fund.  It will help so many for many years to come. 

Any amount will help, but some have asked for  
specific amounts.   

This is my hope for suggested donations: 

Posts with Canteens:  $250  
Posts without Canteens: $100 
Districts:    $200 

Individuals:  Whatever you believe you  
can contribute. 

To donate online, please CLICK HERE, or visit 
http://www.mainelegion.org/pages/foundation/
donate.php; click on the “DONATE TODAY” 
button and choose Fund 001 AL DOM Foundation 
– Endowment Fund and choose Donate with a 
Debit or Credit Card.  

Checks should be made payable to American Legion 
Department of Maine Foundation and mailed to: 
American Legion Department of Maine Foundation, 
5 Verti Drive Winslow, Maine 04901-0727. Please 
make sure to provide your name and address so that 
we may send you a tax receipt.  

Thank you all.  For God and Country.   

Commander Deb Couture 

 

JUNIOR SPORTS SHOOTING  
PROGRAM 

Brunswick Post 20 is starting up 

their junior sports shooting program, 

they are looking for instructor 

and athlete’s. Instructors must go 

to instructor training and have 

background checks to be  

instructors. Athletes must be  

between the ages of 8 and 18, it 

is open to all children, regardless 

if they are children of veterans or 

legion family members, please 

let Joe Donahue 207-607-9735 or 

Dave Watson know, as we would 

like to start up February 24th, there 

is no cost to join or participate in the program. If 

there is any post that would like to start up a JSSP 

please contact Joe or Dave for more information and 

assistance in their start up. 

 

MILITARY TRIVIA 

Q: Following the war of 1812,  

what was the next time that the 
 continental US was attacked  

by a foreign naval vessel?  
 

 

AMERICAN LEGION 
George T. Files Post 20 

Junior 

Junior 
Shooting 
Sports 

207-721-1172 

https://www.paypal.com/donate?token=ZA7E52khU1mQ-mzQQL6Ft5iPkpjLizB5DME__s5KTiNCWWMH2AVzxJU_UZqMWyszyZVc3xOR26t0dkbz
http://www.mainelegion.org/pages/foundation/donate.php
http://www.mainelegion.org/pages/foundation/donate.php
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PORTLAND SEA DOGS  

AMERICAN LEGION DAY 

Saturday, May 21, 2022 

Gates: 11:30 AM, First Pitch: 1:00 PM 

Join the Sea Dogs and  

The American Legion 

for a Ballgame on May 21st  

O n Saturday, May 21st, The Portland Sea Dogs 

are teaming up with the American Legion for a 

fun afternoon at the ballpark when the Sea Dogs take 

on the Harrisburg Senators (AA Affiliate of the 

Washington Nationals). The game is at 1:00 PM and 

the gates open at 11:30 AM. 

Purchase your game tickets by visiting https://

seadogs.formstack.com/forms/legion5_21 and you 

will receive a ticket at a special group price of 

$11.00 ($1.00 off the standard price). Additionally, 

$2.00 per ticket will be donated to the American  

Legion. You will also be invited onto the field 

pregame for a group photo in front of the Maine 

Monster.* 

*Everyone will meet in the left field grandstand  

before 12:15 PM and escorted onto the field shortly 

thereafter for the photo. We will have our Fan Pho-

tographer take the photo, which will be posted on 

our Facebook page in the May 21st Game Day Photo 

Album. 

There is a $2.00 processing fee per order.  

For orders of 10 or more tickets, please call the 

ticket office at 207-879-9500 and ask for Alan. 

If you have any questions, please email 

Abarker@seadogs.com for more information. 

  
JOB OPENING  

Department Finance Officer at 
The American Legion, Department of Maine 

Click on the link above for the job description or 
visit: 

www.mainelegion.org/pages/news-events.php 

 

Reports in MyLegion.org play a vital role with 
tracking membership. The Reports and Labels tab in 
the left-hand navigation menu is the primary  
location to create reports for membership rosters and 
revitalization efforts, as well as communication to 
post and squadron members. The reports are defined 
by officer position and permissions provided as a 
group administrator.   

ABOUT REPORTS 
All reports include filtering options to modify 
reports based on last paid year, status, deliverable 
status and more. Steps to create a report are to 1) set 
filters; 2) view report; and 3) export to another 
application using the export icon.     

In report view, a navigation menu allows you to go 
from page to page using the left and right arrow, or 
use the slide bar at the right. 

The circle arrow icon refreshes your page, and the 
export icon is used to print and save reports. Reports 
are not saved within the report writer. 

When viewing a report, you can search for a member 
to see if they are included. Enter a word or number 
and click Find.  

Available Reports : 

• Mailing Labels •  Consolidated Reports 
• Find Members  •  Member Online Renewals 

in My Area  •  Current Roster 
• Roster Updates  •  Reports   
• Post/Squadron   

For more information CLICK HERE or go to: 

 https://www.legion.org/dispatch/254631/
mylegionorg-reports 

 

 

  
WOMEN VETERANS EVENT 

GUIDELINES 

I f you’re thinking about putting together a Women 
Veterans Event sponsored by the American  

Legion, Department of Maine, please click on the 
above link to help you.  For more information, 
please contact Department HQ at 207-873-3229.   

Guidelines are also available to download by visiting:  
www.mainelegion.org under Forms/

Applications.Forms/ 
 

https://seadogs.formstack.com/forms/legion5_21
https://seadogs.formstack.com/forms/legion5_21
https://Abarker@seadogs.com/
http://www.mainelegion.org/media/misc/DEPARTMENT_FINANCE_OFFICER_01062022.pdf
http://www.mainelegion.org/media/misc/DEPARTMENT_FINANCE_OFFICER_01062022.pdf
http://www.mainelegion.org/media/misc/DEPARTMENT_FINANCE_OFFICER_01062022.pdf
https://www.legion.org/dispatch/254631/mylegionorg-reports
https://www.legion.org/dispatch/mylegion
https://www.legion.org/dispatch/mylegion
http://www.mainelegion.org/pages/formsapplications.php
http://www.mainelegion.org/pages/formsapplications.php
http://www.mainelegion.org/pages/formsapplications.php
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A free Citation of Appreciation is available for your 
use on our web site. Give this certificate to anyone 
who purchases a flag to benefit your Post. 

Microsoft Word Document [DOC] 

Fillable PDF  

Remember: Your Post earns 10¢ for each $1 spent 
on American flags by your Post or sponsors! 

American Legion Flag & Emblem 
5745 Lee Rd., Indianapolis, IN 46216 

(888) 453-4466 

emblem@legion.org 

 

 
 

MILITARY DISCOUNT BENEFIT 
10% OFF EVERY DAY 
TO SALUTE YOUR  
SERVICE 

 

ENJOY YOUR ANNUAL 
MILITARY BENEFIT 
RECEIVE 10% OFF eligible* 

purchases every day, year round—if you are active 
military, retired military or a veteran (spouses, too). 
Sign up for a Virtual ID, then use it to get your dis-
count, however you like to shop: 

in stores 
Online at homedepot.com 
In our mobile app 

JUST APPLY & VERIFY ONCE 

Start Saving in as Little as 5 Minutes 

1. Go to homedepot.com/military/ 
2. Verify your military status  
3. Get your Virtual ID and start shopping! 

 
 

NEW TRAINING VIDEO ON HOW 
TO PROCESS MEMBERSHIP  

MyLegion Training Part 4 – Processing Membership 

or visit https://vimeo.com/showcase/8339635/video/534508932 

All Training Videos➢  MyLegion Training Series  

or visit https://vimeo.com/showcase/8339635 

  New Step-By-Step Instructions & Other Resources to  
Help with Your MyLegion.org Account/Registration 

Useful Step-By-Step Instructions/Information on Mem-
bership Processing, Group Permissions & More! 

A Complete Overview of MyLegion.org (PDF format ) 

A Complete Overview of MyLegion.org (PPTX Format)  

Note: The last Tuesday of each month American  
Legion National Headquarters staff will present 60 
to 90-minute sessions on topics aimed at post  
commanders and adjutants. Each session will be  
recorded and made available for later viewing. 
Please visit Training Tuesdays  for the next sched-
uled training session.   

 

MILITARY TRIVIA:  
 

A: On Feb. 23, 1942, the Japanese submarine,  

I-17, was ordered to shell the fuel storage tanks at 
Elwood, CA. The date coincided with a speech by 
Pres. Roosevelt & the Japanese government wanted 
to embarrass the US. The shelling was ineffectual , 
but it ignited the internment of Japanese Americans 
plus other protective measures.  
 

 
 

http://em.legion.org/c/11FYpCAtYzNyaCBVHI0zi5Qm
http://em.legion.org/c/11FYrFkgmwobBLHFeNkJoK7P
mailto:emblem@legion.org?subject=Flag%20Rewards
https://www.homedepot.com/c/military
http://em.legion.org/c/11FYlx6VcGChikqsDxmf4Nhq
http://em.legion.org/c/11FYnzQHADcUJtwcaCGpbryT
http://em.legion.org/c/11FYtI42KsYP2UNoLSETvopi
https://vimeo.com/showcase/8339635/video/534508932
https://vimeo.com/showcase/8339635/video/534508932
https://vimeo.com/showcase/8339635
https://vimeo.com/showcase/8339635
http://www.mainelegion.org/media/Membership/USEFUL_RESOURCES_TO_HELP_WITH_YOUR_MYLEGION.ORG_ACCOUNT.pdf
http://www.mainelegion.org/media/Membership/USEFUL_RESOURCES_TO_HELP_WITH_YOUR_MYLEGION.ORG_ACCOUNT.pdf
http://www.mainelegion.org/media/Membership/Step_by_Step_Instructions_For_Membership_Processing_Group_Permission_and_More.pdf
http://www.mainelegion.org/media/Membership/Step_by_Step_Instructions_For_Membership_Processing_Group_Permission_and_More.pdf
http://www.mainelegion.org/media/Membership/MyLegion_Workshop_2021_-_Complete_Overview_with_notes_Aug-2021.pdf
http://www.legion.org/documents/training/training-tuesdays/MyLegion%20Workshop%202021%20-%20Complete%20Overview.pptx
https://www.legion.org/training/training-tuesdays
http://www.mainelegion.org/media/Membership/MyLegion_Workshop_2021_-_Complete_Overview_with_notes_Aug-2021.pdf
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Computer 101 is a resource which aims to help 
those who wish to learn basic skills with the powerful 
technology of today’s world. Increased proficiency 
with computers and the Internet has positive outcome 
across all fronts, both personally and professionally.  

Create a Presentation In PowerPoint 

1. Open PowerPoint. 
2. In the left pane, select New. 
3. Select an option: 

• To create a presentation from scratch, select 
Blank Presentation. 

• To use a prepared design, select one of the  
templates. 

• To see tips for using PowerPoint, select Take  
a Tour, and then select Create, . 

 
Add a Slide 
1. In the thumbnails on the left pane, select the  

slide you want your new slide to follow. 
2. In the Home tab, in the Slides section, select 

New Slide. 
3. In the Slides section, select Layout, and then  

select the layout you want from the menu. 
 
Add and format text 
1. Place the cursor inside a text box, and then type 

something. 
2. Select the text, and then select one or more  

options from the Font section of the Home tab, 
such as Font, Increase Font Size, Decrease  
Font Size, Bold, Italic, Underline, etc. 

3. To create bulleted or numbered lists, select the 
text, and then select Bullets or Numbering. 

 
Add a picture, shape, and more 
1. Go to the Insert tab. 
2. To add a picture: 

• In the Images section, select Pictures. 
• In the Insert Picture From menu, select  

the source you want. 
• Browse for the picture you want, select it,  

and then select Insert. 
3.  To add illustrations: 

• In the Illustrations section, select Shapes, 
Icons, 3D Models, SmartArt, or Chart. 

• In the dialog box that opens when you click  
one of the illustration types, select the item  
you want and follow the prompts to insert it. 

~ Microsoft 
 

A nyone who is currently an 

American Legion member or 

who is eligible for membership may 

become a PUFL member. Legion-

naires can apply for membership 

online at:  www.legion.org/pufl. 

Find an application at the end of this newsletter. 

Visit www.mainelegion.org Forms/Applications for 
more information. 

Paid Up for Life Pricing  
(For post dues of $48.00 or less) 

 
 

 

When paid in full the member will receive a permanent 
plastic card identifying him/her as a lifetime  
member. The PUFL member will also continue to 
receive an annual American Legion membership 
card mailed directly on or about July 1st of each year. 

Lifetime membership can be paid either in one  
single lump sum or over 12 equal, monthly  
payments. If a member chooses the Time Pay Plan, 
payment must be made by credit card only. (Check 
for online promotions if paying in full.) Once a 
member fulfills the PUFL membership dues, he/she 
will be protected from any future dues increases at 
the post, department or national levels. See pages 12 
& 13 for application. 

 

MEMBERSHIP IMPACT REPORTS 

T he American Legion’s success depends entirely 
on active membership, participation and volun-

teerism. The following monthly reports located on: 
https://www.legion.org/membership/impact pro-
vide a summary of membership, participation and 
volunteerism making an impact in the lives of veter-
ans, families and communities. American Legion 
Posts can share the many ways Legionnaires are 
making a difference in their communities by sub-
mitting consolidated post reports online. To visit 
the impact American Legion posts made throughout 
the year, visit: https://www.legion.org/
bythenumbers   or https://www.legion.org/
membership/impact. 

 

PAST COMMANDERS CLUB 

P lease note that the annual dues for Past  
Commanders Club have increased to $5.00/

member. See Page 12 for an application. 

https://www.legion.org/join/pufl
https://support.microsoft.com/en-us/office/create-a-presentation-in-powerpoint-422250f8-5721-4cea-92cc-202fa7b89617
http://www.mainelegion.org/pages/formsapplications.php
https://www.legion.org/membership/impact
https://www.legion.org/membership/impact
http://www.mylegion.org/
http://www.mylegion.org/
https://www.legion.org/bythenumbers
https://www.legion.org/bythenumbers
https://www.legion.org/membership/impact
https://www.legion.org/membership/impact
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Bringing you all the latest from  
The Legionnaire Insurance Trust 
 

We are mailing Emergency Assistance Plus (EA+) 
on February 23rd. 

Quick reminder about EA+: If you’re traveling away 
from home and experience a medical emergency, EA+ 
steps in to provide essential support services that can 
help you during your emergency. Services include: 
• Medical Evacuation to get you to a more   

appropriate hospital. 
• Transportation Home after hospitalization. 
• Nurse Escort to help you travel if deemed  

medically necessary. 
• Return of Vehicle if it is stranded due to your emergency. 
• And More! 
Product may not be available in all states and may 
not mail all your members. If you want a more  
detailed description of this product, visit: 
www.TheLIT.com/Emergency-Assistance-Plus.   

 
CLICK HERE FOR CONTENT TO SPREAD THE WORD  

 
➢ The next mailing is HospitalHELP in March. 
➢ Only a few days left to submit your Depart-

ment's entry for the Wigle Membership 
Innovation Initiative! If you need more  
information, reach out to Howard Bender.  

 

 
Brought to you by: 

The Legionnaire Insurance Trust 
Facebook 

Questions? Contact Howard Bender 
800-445-3269 | hbender@agia.com 

 

The American Legion Department of Maine 

General Fund   

Quirino Lucarelli……………………… $100.00 

THE American Legion  
Department of Maine Foundation 

2022 Commanders Project – Couture 
Wiscasset Post 54…………………..... $100.00 
Kennebec District 9 …………………. $200.00 
 

 

EMERGENCY FINANCIAL  
ASSISTANCE PROGRAM (VEFAP) 

D o you know of a veteran in your community in 
need of assistance? Someone who during these 

challenging times just needs a little help to keep 
them going? Maybe a veteran that is homeless? Or 
worst of all, a homeless veteran with children? If so, 
we want to remind you that The American Legion, 
Department of Maine can assist you to help these 
veterans during their difficult and troubling times. 

Please call 207-660-9324 or 207-873-3229 Ext. 3. 
For more information visit our website: 

http://www.mainelegion.org/pages/ 
resources/va-resources.php 

We will contact you as soon as possible and we 
hope to enable you to help veterans in need. 

 

“The world is a dangerous place,  
not because of those who do evil, but because  

of those who look on and do nothing.”  

~ Albert Einstein 

 

 

 

Page 64: Post 85 – Adjutant corrected to: Butler 
Smythe, P.O. Box 104, 37 Penberton 
Lane, Blue Hill, ME 04614 (374-3838)  
(c 240-298-2602) 
e-mail: thbsmythe@gmail.com 

Page 30: Post 123 – Commander Albert Springer 
has passed away so there is no longer a 
Commander or Service Officer at this post. 

https://www.thelit.com/emergency-assistance-plus
http://www.thelit.com/MediaKit?ProductTab=Emergency%20Assistance%20Plus
https://www.facebook.com/LegionnaireInsurance
mailto:hbender@agia.com?subject=LIT%20News%20Question
http://www.thelit.com/legioncare2
http://www.mainelegion.org/pages/resources/va-resources.php
http://www.mainelegion.org/pages/resources/va-resources.php
http://www.mainelegion.org/pages/resources/va-resources.php
https://everydaypower.com/albert-einstein-quotes/
https://www.facebook.com/LegionnaireInsurance
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This form may be filled out on-line at:  www.mainelegion.org/pages/formsapplications.php 

*** Please note that the annual dues for Past Commanders Club have increased to $5.00/member)*** 

http://www.mainelegion.org/pages/formsapplications.php

